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1. Introduction

The Cypress Semiconductor EZ-USB® NX2LP-Flex™ Controller chip (CY7C68033) is a
programmable USB NAND controller based on the FX2LP (CY7C68013A) silicon. The NX2LP-Flex
architecture enables USB data transfer rates of over 53 MB for every second. This is the maximum
allowable USB 2.0 bandwidth, while still using a low-cost 8051 microcontroller in a small 56-pin QFN
package While both CY7C68033 and CY7C68034 are functionally similar, the latter is more
appropriate for battery-powered applications because of its low standby power consumption. 

The CY3686 EZ-USB NX2LP-Flex Development Kit (DVK) is provided to customers for evaluating
and developing NAND Flash USB mass storage applications using the NX2LP-Flex controller. The
CY3686 NX2LP-Flex DVK is a combination of two development platforms:

■ The CY3684 EZ-USB FX2LP-DVK, based on Cypress's most popular USB 2.0 general purpose 
microcontroller, the EZ-USB FX2LP

■ The NX2LP-Flex development board, based on Cypress's NAND flash controller EZ-USB 
NX2LP-Flex

This enables users to integrate their custom application with NAND flash solutions. 

This chapter gives an overview of the DVK. Chapter 2 describes the installation of the CY3686
NX2LP-Flex DVK kit and drivers. Chapter 3 describes the utilities provided with the kit and firmware
debugging with Keil uVision. Chapter 4 describes the kit hardware. Chapter 5 describes the NX2LP
NAND Programming utility. The Appendix chapter describes firmware design notes, USB Mass
Storage testing, handling SOP sockets, schematics and layout, and frequently asked questions
associated with the CY3686 NX2LP-Flex DVK.

1.1 CY3686 EZ-USB NX2LP-Flex DVK Features
This kit provides:

■ NAND flash firmware source code with the following features:

❐ 512-page, 2K-page, and 4K-page NAND type support

❐ Composite device class (that is, USB Mass Storage Class combined with HID Class)

❐ Removable/unremovable device configuration

❐ USB BULK only mass storage device class support

❐ Windows boot support

❐ Autorun support

❐ 2-NAND chips select and 8-NAND chips select support

■ The CY3686 EZ-USB NX2LP-Flex DVK debugging platform, which includes:

❐ C-level single-step debugging capability with breakpoints using the FX2LP base board

❐ NAND flash programming tool for developing and manufacturing support

❐ Prototyping board for user add-on hardware

❐ NX2LP-Flex board with sockets and NAND flash chips

■ Basic 4K Keil C Compiler (evaluation compiler for the Cypress EZ-USB family)

http://www.cypress.com/?rID=14321
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■ NAND flash manufacturing utility programs

❐ NandMfg.exe (NAND flash programming tool)

❐ BldNx2.exe (Build configuration file)

■ GPIF designer tool

■ MAC OS 9.x drivers available at http://www.cypress.com/?rID=14396

1.2 CY3686 EZ-USB NX2LP-Flex DVK Contents

The development kit includes:

■ EZ-USB advanced development board (FX2LP base board)

■ EZ-USB prototyping board ("Breadboard")

■ NX2LP-Flex board populated with two NAND flash devices

■ USB cable

■ RS-232 cable

■ CY7C68033 sample chips

■ NAND manufacturing utility

■ CY3686 firmware and BldNx2 utility

■ GPIF Designer 

■ Kit CD/DVD with documentation

1.3 System Requirements

The CY3686 EZ-USB NX2LP-Flex DVK has the following system requirements:

■ Microsoft Windows XP/Windows Vista/Windows 7

■ Microsoft .NET Framework v2.0 or later

■ Administrative privileges on the system

■ 64 MB RAM (256 MB recommended)

■ Pentium IV-class PC (1 GHz or higher recommended)

■ Super VGA display (resolution 800 × 600 or higher)

■ USB Host Controller (full-speed or high-speed)

The NAND development tools (such as, NANDMfg.exe, BldNx2.exe, and so on) are supported on
Windows XP, Windows Vista, and Windows 7 and not on Mac or Linux OS. However, after the NAND
flash is programmed, the Cypress EZ-USB NX2LP development board and the EZ-USB NX2LP
NAND flash Controller operate in a Mac and Linux environment if the OS supports USB mass
storage devices.

1.4 Additional Learning Resources
■ CY3686 NX2LP Development Kit (http://www.cypress.com/?rID=14320)

■ NX2LP Compatible NAND list (http://www.cypress.com/?docID=21757)

■ CY3684 FX2LP Development Kit (http://www.cypress.com/?rID=14321)

■ USB 2.0 to ATA/CF Reference Design – CY4611B (http://www.cypress.com/?rID=14406)

■ Interfacing Cypress CY3686 DVK to NAND Flash Memory with Four Chip Selects - AN41299
(http://www.cypress.com/?rID=12958)

■ Getting Started With NX2LP-Flex™ - AN64408 (http://www.cypress.com/?rID=46712)

■ NX2LP-Flex™ USB to NAND Flash Firmware Design Notes - AN61347
 (http://www.cypress.com/?rID=43431)

http://www.cypress.com/?rID=14320
http://www.cypress.com/?docID=21757
http://www.cypress.com/?rID=14321
http://www.cypress.com/?rID=14321
http://www.cypress.com/?rID=14396
http://www.cypress.com/?rID=14406
http://www.cypress.com/?rID=46712
http://www.cypress.com/?rID=12958
http://www.cypress.com/?rID=43431
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1.5 Technical Support

For feedback or technical support for the CY3686 EZ-USB NX2LP-Flex DVK, contact Cypress at
http://www.cypress.com > Technical Support > Create a Case.

1.6 References
■ USB Mass Storage Class - Bulk Only Transport, USB Mass Storage DWG.

 (http://www.usb.org/developers/devclass_docs/usbmassbulk_10.pdf)

■ USB Mass Storage Class - Specification Overview, USB Mass Storage DWG
 (http://www.usb.org/developers/devclass_docs/Mass_Storage_Specification_Overview_v1.4_2-19-2010.pdf)

■ USB Specification - Revision 2.0, USB Implementers Forum. 
(http://www.usb.org/developers/docs)

■ EZ-USB Technical Reference Manual for FX2LP, Revision 1.2, Cypress
 (http://www.cypress.com/?rID=38232)

■ NX2LP-Flex data sheet (http://www.cypress.com/?rID=14187)

■ SCSI-3 Specification (http://t10.org/scsi-3.htm)

1.7 Acronyms
Acronym Description

2K-NAND Nand flash with page size = 2112

4K-NAND NAND flash with page size ≥ 4224

512-NAND NAND flash with page size = 528

CBW Command block wrapper. A packet containing a command block and associated information.

CSW Command status wrapper. A packet containing the status of a command block.

ECC Error correcting code. Logic designed to detect and correct memory errors

GPIO General purpose I/O 

SCSI Small computer system Interface

http://www.usb.org/developers/devclass_docs/usbmassbulk_10.pdf
http://www.usb.org/developers/devclass_docs/Mass_Storage_Specification_Overview_v1.4_2-19-2010.pdf
http://www.usb.org/developers/docs
http://www.cypress.com/?rID=38232
http://www.cypress.com/?rID=14187
http://t10.org/scsi-3.htm
http://www.cypress.com
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1.8 Document History

1.9 Documentation Conventions 

Revision
PDF Creation 

Date
Origin of Change Description of Change

** 05/04/10 SHAH Initial version of kit guide

*A 08/10/2012 VKKN/NMMA
Updates from review/audit, NAND utility 
software upgrade

*B 06/05/2013 HBM
No technical updates. Completing 
Sunset Review.

Table 1-1.  Document Conventions for Guides

Convention Usage

Courier New
Displays file locations, user entered text, and source code:
C:\ ...cd\icc\

Italics
Displays file names and reference documentation:
Read about the sourcefile.hex file in the PSoC Designer User Guide.

[Bracketed, Bold]
Displays keyboard commands in procedures:
[Enter] or [Ctrl] [C]

File > Open
Represents menu paths:
File > Open > New Project

Bold
Displays commands, menu paths, and icon names in procedures:
Click the File icon and then click Open.

Times New Roman
Displays an equation:
2 + 2 = 4

Text in gray boxes Describes cautions or unique functionality of the product.
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2. Getting Started

This chapter describes the installation and configuration of the CY3686 EZ-USB NX2LP-Flex DVK.

2.1 Kit Installation

To install the kit software, follow these steps:

1. Insert the kit CD/DVD in the CD/DVD drive of your PC. The CD/DVD is designed to auto-run and 
the kit installer startup screen appears. 
Download the latest kit installer ISO file from http://www.cypress.com/go/CY3686. Create an 
installer CD/DVD or extract the ISO using Winrar and install the executable.

2. Click Install CY3686 NX2LP-FLEX DVK to start the installation.

Figure 2-1.  Kit Installer Startup Screen

http://www.cypress.com/go/CY3686
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If auto-run does not execute, double-click cyautorun.exe in the root directory of the CD/DVD.

Figure 2-2.  CD/DVD Root Directory

3. On the startup screen, click Next to start the installer.

4. The InstallShield Wizard screen appears. Click Change to modify the default setup location  
shown on the InstallShield Wizard screen.

5. Click Next to launch the kit installer.

Figure 2-3.  InstallShield Wizard
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6. In the Product Installation Overview screen, select the installation type that best suits your 
requirement. The drop-down menu has three options: Typical, Complete, and Custom.

Figure 2-4.  Installation Type Options

7. Click Next to start the installation.

8. Accept the license agreement.

Figure 2-5.  License Agreement
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9. When the installation begins, a list of packages appears on the Installation Page. A green check 
mark appears next to every package you download and install.

10.Wait until all the packages are downloaded and installed successfully.

Figure 2-6.  Installation Page

11.The CY3686 kit contains Keil uVision2 evaluation version with a code limit of 4K. The Keil 
uVision2 Welcome screen pops up. Click Next.

Figure 2-7.  Keil uVision2 Welcome Screen
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12.In the subsequent windows, select Next until the Keil install screen prompts for the ‘User Name’ 
and ‘Company Name’. Enter the details (the following screenshot has a sample).

Figure 2-8.  Customer Information Page

13.In subsequent windows, click Next until the Keil Installer displays the Finish window. Click on 
Finish to complete the entire Keil uVision2 installation process.

Note The Keil uVision 2 is installed only if it is a fresh install. If it was installed earlier, then only the
DVK contents are installed. This is an evaluation version of Keil uVision2 and is only useful for open-
ing the Keil project (CY3686fw.Uv2). To edit and compile the CY3686 NX2LP-Flex firmware source
files, purchase a full version of the Keil 8051 software from Keil Software at www.keil.com.

Figure 2-9.  Keil Installation Completion Page

www.keil.com
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14.Click Finish to complete the kit installation.

Figure 2-10.  Installation Completion Page

Note Download and install the GPIF designer tool from www.cypress.com/go/CY3686.

2.2 Installing the CY3686 DVK Device Drivers

The FX2LP base board, the prototype board, and the NX2LP-Flex board can be stacked up with dif-
ferent settings to create different configurations as described in section 3.2, Board Configuration.
While each of them has different purposes and debug capabilities, only five of them are unique from
the host PC's point of view and require installation of drivers when connected to the host for the first
time. Following are the five unique settings:

■ Configuration 1

The EEPROM switch settings on the FX2LP base board are as follows:

1. SW1 – Not applicable

2. SW2 – No EEPROM

In this configuration, only the FX2LP board is recognized by the host PC. The device appears as
‘Cypress EZ-USB FX2LP No EEPROM (3.4.5.000)’ in the Device Manager with VID = 0x04B4 and
PID = 0x8613.

■ Configuration 2

The EEPROM switch settings on the FX2LP base board are as follows:

1. SW1 – Large EEPROM (programmed with "loader.iic")

2. SW2 – EEPROM

3. NANDMfg.exe utility is not open

www.cypress.com/go/CY3686
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The NX2LP Flex board is set with nothing connected on Pad U1 and U2. The switches and jumpers
are left in their default setting. The FX2LP board (with the NX2LP Flex board stacked on top) is con-
nected to the host PC. When there is no NAND flash populated in the NAND sockets or when an un-
programmed NAND part (no NX2LP user firmware image) is mounted on the NAND socket of the
NX2LP-Flex board, the device appears as ‘Cypress EZ-USB NX2LP-Flex BootLoader(3.4.5.000)’ in
the Device Manager with VID = 0x04B4 and PID = 0x6823. 

■ Configuration 3

The EEPROM switch settings on the FX2LP base board are as follows:

1. SW1 – Large EEPROM (programmed with "loader.iic")

2. SW2 – EEPROM

3. NANDMfg.exe utility is open

The NX2LP Flex board is set with nothing connected on Pad U1 and U2. The switches and jumpers
are left in their default setting. The FX2LP board (with the NX2LP Flex board stacked on top) is con-
nected to the host PC. When there is no NAND flash populated in the NAND sockets or when an un-
programmed NAND part (no NX2LP user firmware image) is mounted on the NAND socket of the
NX2LP-Flex board, the device appears as ‘Cypress EZ-USB NX2LP-Flex Unprogrammed
NAND(3.4.5.000)’ in the Device Manager with VID = 0x04B4 and PID = 0x4617.

■ Configuration 4

The EEPROM switch settings on the FX2LP base board are as follows:

1. SW1 – Large EEPROM (programmed with "loader.iic")

2. SW2 – EEPROM

The NX2LP Flex board is set with nothing connected on Pad U1 and U2. The switches and jumpers
are left in their default setting. The FX2LP board (with the NX2LP Flex board stacked on top) is con-
nected to the host PC. When a NAND flash, programmed with CY3686FW, is mounted on the NAND
socket of this board, the device appears as a ‘USB Mass Storage Device’ in the Device Manager
with VID = 0x04B4 and PID = 0xXXXX (enter the PID using the NANDMfg utility while programming).
A removable drive appears in My Computer.

■ Configuration 5

The EEPROM switch settings on the FX2LP base board are as follows:

1. SW1 – Small EEPROM (programmed with NX2LP-Small EEPROM.iic)

2. SW2 – EEPROM

The NX2LP Flex board is set with nothing connected on Pad U1 and U2. The switches and jumpers
are left in their default setting. The FX2LP board (with the NX2LP-Flex board stacked on top) is con-
nected to the host PC. The host recognizes the device as ‘Cypress EZ-USB FX2LP Board Keil mon-
itor (3.4.5.000)’, with VID = 0x04B4 and PID = 0x0082.
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2.2.1 Driver Installation

The drivers for the configurations’ (mentioned in the previous section) VID/PID are signed by Micro-
soft. Driver installation is required only the first time. To install the CY3686 NX2LP-Flex DVK driver,
follow this procedure:

1. Connect USB A-to-B cable between the PC USB Host controller port and the Type-B connector 
on the FX2LP base board.

2. The Hardware Update wizard window pops up. Select No, not this time and click Next.

In Windows Vista and Windows 7 systems, the Found New Hardware wizard pops up. Select Locate
and install driver software (recommended). Select Continue when asked for administrator per-
mission.

Figure 2-11.  New Hardware Found

3.  In the next window, select Install from a list or a specific location (Advanced) and click Next. 
In Windows Vista and Windows 7, select Browse my computer for driver software 
(Advanced).
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Figure 2-12.  Hardware Update Wizard

4. Select Don't search. I will choose the driver to install and click Next.

Figure 2-13.  Choose Installation Options

Note In Windows Vista and Windows 7, step 4 is not needed. 
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5. Select "Universal Serial Bus Controllers" from the list of devices and click on Have Disk in the 
next window. A new window appears on top of the existing window.

6. Click Browse and point to the driver path for each OS and select the driver information file 
(cyusb3686dvk.inf) as mentioned in the following paths. The USB driver path varies depending 
on the Windows OS to which the CY3686 DVK is connected. Following are relative paths with ref-
erence to the directory, <install directory>\CY3686 NX2LP-FLEX DVK\<ver>\Drivers

a. Windows XP 32-bit: wxp\x86

b. Windows XP 64-bit: wxp\x64

c. Windows Vista 32-bit: wlh-vista\x86

d. Windows Vista 64-bit: wlh-vista \x64

e. Windows 7 32-bit: wlh-win7\x86

f. Windows 7 64-bit: wlh-win7\x64

Note For configurations 1 to 4 use the cyusb3686dvk.inf file in the cyusb3686dvk folder. For config-
uration 5, use the CyMonfx1_fx2lp.inf file in the CyMonfx1_fx2lp directory.

Figure 2-14.  Select the .inf file
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7. Click Next and the complete the installation.

Figure 2-15.  Driver Installation Complete
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3. Kit Operation

This chapter explains the CY3686 NX2LP-Flex DVK operation.

3.1 Quick Start

The CY3686 EZ-USB NX2LP-Flex DVK default configuration is detected as a USB mass storage
device when connected to the host PC for the first time. The NX2LP-Flex board comes with two pro-
grammed NAND flashes populated in the NAND slots. The FX2LP base board Large EEPROM is
pre-loaded with loader.iic, which causes the FX2LP to emulate as an NX2LP-Flex.

1. Stack the FX2LP base board, FX2LP prototype board (optional), and the NX2LP-flex board

2. Verify if the settings on the FX2LP base board for switches SW1 and SW2 are identical to 
Figure 4-2 on page 39.

3. For more information on the jumper settings, refer to Table 4-1 on page 43.

4. Using the USB A-B cable provided, connect the FX2LP base board USB-B port to the Host PC.

5. The device now enumerates as a USB mass storage device and a removable disk appears on 
My Computer

3.2 Board Configuration

One of the following two combinations of board stackup is used:

1. FX2LP base board + FX2LP prototype board (Optional) + NX2LP-flex board

Figure 3-1.  Board Stackup for NX2LP Emulation using FX2LP
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2. NX2LP-Flex board + FX2LP prototype board (optional)

Figure 3-2.  NX2LP-Flex DVK Standalone Operation

The following table lists useful configurations with CY3686 boards.

Table 3-1.  Useful Board Configurations

Board
Stackup

Board Settings* Board Function Tools and function

FX2LP
Base

NX2LP-Flex
FX2LP
Base

NX2LP-Flex

FX2LP Base Board+ 
Prototyping Board + 
NX2LP-Flex Board

SW1 : Small EEPROM
SW2: EEPROM

UART cable between 
PC and SIO-I

USB A-B cable between 
host PC and connector 
on board

Pad U1: 
NC (unpopulated)

Pad U2: NC

Unprogrammed 
NAND flash device 

FX2LP running 
NAND user firmware
in debug mode 

Housing for NAND 
flash device

Keil tool for compiling 
and debugging firm-
ware

EZUSB FX2LP DVK 
Keil monitor driver for 
handling USB com-
munication. 

FX2LP Base Board+ 
Prototyping Board + 
NX2LP- Flex Board

SW1 : Large EEPROM

SW2: EEPROM

USB A-B cable between 
host PC and connector 
on board

Pad U1: 
NC (unpopulated)

Pad U2: NC

Unprogrammed 
NAND flash device

FX2LP + “loader.iic” 
on large EEPROM 
emulating NX2LP 
programs flash with 
image

LED’s and push but-
tons for limited 
debug

Housing for NAND 
flash device. 

NAND flash device  
stores user firmware 
image

Keil tool for compiling 
firmware

NAND firmware pack-
ager- packaging firm-
ware to .Nx2

NAND programming 
utility to program firm-
ware image into flash

Nand controller  Keil 
monitor driver for 
handling USB com-
munication.

FX2LP Board+ 

Prototyping Board +

NX2LP- Flex Board

SW1 : Large EEPROM

SW2: EEPROM

USB A-B cable between 
host PC and connector 
on board

Pad U1: NC

Pad U2: NC

Programmed NAND 
flash device

Power and housing 
for FX2LP part and 
the large EEPROM 
that emulate NX2LP 
USB-flash controller

Housing for NAND 
flash device. 

Firmware image is 
loaded from pro-
grammed NAND 
flash device 

Mass Storage USB 
drivers to perform 
data transfers 
between host PC and 
NAND flash
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*Note The prototyping board is optional and is required only if the user wants to add hardware that
draws input and feeds output to any of the signals on any of the six 20-pin headers.

NX2LP- Flex Board+ 
Prototyping Board

-

Pad U1: 

CY7C68013

(FX2LP)

Pad U2: large 
EEPROM with 
“loader.iic”

Unprogrammed 
NAND flash device

-

FX2LP + “loader.iic” 
on large EEPROM 
emulating NX2LP 
programs flash with 
image

Housing for NAND 
flash device

NAND flash device 
stores user firmware 
image

Keil tool for compiling 
firmware

NAND firmware pack-
ager- packaging firm-
ware to .Nx2

NAND programming 
utility to program firm-
ware image into flash

Nand controller 
device driver for han-
dling USB communi-
cation

NX2LP- Flex Board+ 
Prototyping Board

-

Pad U1: 

CY7C68013

(FX2LP)

Pad U2: large 
EEPROM with 
“loader.iic”

Programmed NAND 
flash device

-

FX2LP + “loader.iic” 
on large EEPROM 
emulating NX2LP 

USB-flash controller

Housing for NAND 
flash device 

Firmware image is 
loaded from pro-
grammed NAND 
flash device

Mass Storage USB 
drivers to perform 
data transfers 
between host PC and 
NAND flash

NX2LP- Flex Board+ 
Prototyping Board

Pad U1: 

CY7C68033/34 
(NX2LP)

Pad U2: NC

Unprogrammed 
NAND flash device

NAND controller 
NX2LP programs 
the attached NAND 
flash device 

NAND flash device 
also stores user firm-
ware image

Keil tool for compiling 
firmware

NAND firmware pack-
ager- packaging firm-
ware to .Nx2

NAND programming 
utility to program firm-
ware image into flash

Nand controller 
device driver for han-
dling USB communi-
cation

NX2LP- Flex Board+ 
Prototyping Board

Pad U1: 

CY7C68033/34 
(NX2LP)

Pad U2: NC

Programmed NAND 
flash device

NAND controller 
NX2LP provides 
USB-flash manage-
ment 

Firmware image is 
loaded from pro-
grammed NAND 
flash

Mass Storage USB 
drivers to perform 
data transfers 
between host PC and 
NAND flash

Table 3-1.  Useful Board Configurations

Board
Stackup

Board Settings* Board Function Tools and function

FX2LP
Base

NX2LP-Flex
FX2LP
Base

NX2LP-Flex
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3.3  NX2LP Utilities

This section describes the various DVK utilities.

3.3.1 CyConsole Utility

The Large EEPROM on the FX2LP base board comes pre-loaded with the loader.iic, which is avail-
able at <Installed_directory>\CY3686 NX2LP-FLEX DVK\<Ver>\Bootloader. If the
EEPROM image is corrupted, you can reprogram the EEPROM using the CyConsole utility. Use the
following procedure to program the EEPROM:

1. Connect the FX2LP base board and NX2LP-Flex board stackup to the host PC. Make sure the 
SW2 switch on the FX2LP base board is in the No EEPROM position.

2. Launch the utility from <install directory>\CY3686 NX2LP-FLEX 
DVK\<ver>\Bin\CyConsole.exe

Figure 3-3.  CyConsole
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3. Go to Options > EZ-USB Interface

Figure 3-4.  EZ-USB Interface

4. Click on Lg EEPROM and select the loader.iic file to be programmed from 
<Installed_directory>\CY3686 NX2LP-FLEX DVK\<Ver>\Bootloader. Make sure the 
SW2 switch on the FX2LP base board is in the 'EEPROM' position and SW1 to LARGE EEPROM 
position.
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Figure 3-5.  Select File

5.  When programming is complete, the Download Successful message appears in the display 
area.

Figure 3-6.  Programming Complete
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3.3.2  NAND FW Packaging Utility

When the firmware is stable, use the NX2LP firmware packaging utility to package it by
selecting from <install directory>\CY3686 NX2LP-FLEX DVK\<ver>\Bin\BldNx2.exe.
The following figure shows the NX2LP Firmware Packager (NX2LP configuration utility) window. 

Figure 3-7.  NAND FW Packaging Utility

 This utility is used to convert a .hex file to a .nx2 file. Follow this procedure to package the firmware
using the BldNX2.exe utility:

1. Click Browse and go to the 512 Bpp FW  file; select the following file:
<install directory>\CY3686NX2LP-FLEX DVK\<ver>\CY3686FW\inand_fw.hex

2. Provide a firmware version, such as "201001512", in the version box.

3. In the slot adjacent to the 2K Bpp FW file, select the nand_mc2k.hex for a 2K-page NAND from 
the directory mentioned in step 1. Enter the output file name Default2K.nx2. Set the version (for 
example, 2010012K). 
Click Build File to generate the file.The output file contains NAND firmware in both the 512-byte 
and 2-K page sizes and the relevant firmware for a specific NAND is downloaded by the NAND-
MFG tool.

4. For the 4-K page NAND device, select nand_mc4k.hex from the same folder. Also select 
inand_fw.hex. Enter the output file name, Default4K.nx2. Set the version (for example, 
2010014K). Click Build File to generate the file.The output file contains NAND firmware in both 
512-byte and 4-K page sizes and the relevant firmware for a specific NAND is downloaded by the 
NANDMFG tool.

5. Verify that the output file is created in the desired directory.

3.3.3 NAND Programming Utility

The NX2LP NAND Programming Utility is an application specifically designed to download vendor
configuration parameters to an NX2LP NAND memory device and automatically initialize it with
FAT32 formatting.

The utility can be used to program previously unprogrammed (that is, "raw") NAND devices or to
reprogram preconfigured NAND devices and enumerate as Windows Mass Storage Class devices.

The NAND flash can be programmed using the NANDMfg.exe tool by following this procedure:



28 CY3686 EZ-USB® NX2LP-Flex™ Development Kit Guide, Doc. # 001-61287 Rev. *B

Kit Operation

1. Launch the utility either from the shortcut on the desktop or from <install direc-
tory>\CY3686 NX2LP-FLEX DVK\<ver>\MfgTool\NandMfg.exe. Ensure that the tool is 
not locked. The File > Lock option must not be checked.

Figure 3-8.  NAND Programming Utility

 Note In Windows 7, the utility may not recognize the device and the status bar on the bottom of the
utility remains blank. If this occurs, launch the utility from <install directory>\CY3686
NX2LP-FLEX DVK\<ver>\MfgTool\ only. Right click on the exe and select the 'Run as adminis-
trator' option.

2. Connect the NX2LP-Flex DVK to the host PC. When an unprogrammed NAND device is detected 
by the Programming Utility, the message displayed on the status bar at the bottom of the utility 
changes as shown in the following screenshot. If Add New Part pops up, follow the instructions 
given in section 5.7.

Figure 3-9.  Unprogrammed USB Device
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3.  Select the configuration file from File > Select Configuration. The configuration files are in the 
folder, <install directory>\CY3686 NX2LP-FLEX DVK\<ver>\MfgTool\.

Figure 3-10.  Select Configuration File

■ Default4K.nx2 – Default firmware package for 4K-page NAND

■ Default2K.nx2 – Default firmware package for 512 or 2K-page NAND

■ DeleteAll.nx2 – The firmware package for 512/2k page flashes, which erase all of the blocks irre-
spective of the block status (that marks it good or bad). When the CTL + W command is issued 
using the NandMfg utility, with this firmware running, it erases all the blocks, including the ‘Bad’ 
blocks. Note that this also erases the Bad block information marked by the vendor.  

■ 4kDeleteALL.nx2 – The firmware package for 4k page flashes, which erase all the blocks irre-
spective of the block status (that marks it good or bad). When the CTL + W command is issued 
using the NandMfg utility, with this firmware running, it erases all the blocks, including the ‘Bad’ 
blocks. Note that this also erases the Bad block information marked by the vendor. 

Note The default firmware packages (Default2k.nx2 and Defualt4k.nx2) erase only the good blocks
on issuing the CTL + W command. The DeleteAll firmware packages command must be used only
for debugging or recovery, if you corrupt the flash causing the blocks to be incorrectly marked as
bad.

4. To program the vendor parameters and configuration settings to the device, click Wipe and Pro-
gram Device. Clicking this button erases the NAND, programs the firmware to it, and formats it. 
Press RESET button S1 on the FX2LP board after this to observe the NAND flash device enu-
merate as a removable disk.

5. You can also perform the process mentioned in step 4 in different stages. Press CTRL + W for 
erase and then press the RESET button S1 on the board. Click Device > Program in the NAND-
MFG tool to program and format the NAND device. Note that the NANDMFG tool does not acti-
vate the Program option unless you erase and RESET the board. This step is optional and the 
same can be achieved in a single step using the Wipe and Program Device button click (see 
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step 4). Do not program a formatted NAND unless it is erased earlier; not following this corrupts 
the device.

Note NandMfg supports formatting only for flashes with 2k-/512-byte page size. It relies on the host
to format 4k page flashes.

Figure 3-11.  Program Device

5. At this point, the device is configured as a fully-functional USB Mass Storage Class device. More 
details on the use of the manufacturing utility are given in Chapter 5.

Note While programming the NAND flash using the NANDMfg.exe, ensure that the PID displayed on
the utility is not 0x4617/0x8613/0x6823/0x0082. If it displays any of the mentioned PIDs in the Prod-
uct ID field, then manually change the value in the utility (see the following image) to any value of
your choice other than the above mentioned PIDs. The PIDs  mentioned in this section are signed by
Microsoft for the cyusb.sys driver. When programmed with these PIDs, the programmed NAND flash
does not enumerate as a USB Mass Storage Device.

Figure 3-12.  Product ID (PID) Value

For more details on using the utility, refer to NAND Manufacturing Utility on page 47.
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3.4 Debugging using Keil uVision

The CY3686 NX2LP-Flex DVK firmware is located at <install directory>\CY3686 NX2LP-
FLEX DVK\<ver>\CY3686FW. The description of the firmware files is given in the following table.

Filename Purpose

Dscr.a51 
Descriptor table containing PID/VID, endpoint descriptions, and other information reported to 
the host on startup.

reset.a51 Assembly routine used to branch to 0 on USB reset.

Startup.a51 Modified Keil startup file that does not initialize any variables.

USBjmptbl.a51 
USB interrupt vector table for FX2LP and NX2LP-Flex: When the NX2LP flag is defined, it 
selects the NX2LP interrupt vector 

inand.c

NAND flash subroutines that handle SCSI reads and writes. The subroutines are:

InitNand: NAND hardware/software initialization

nGetFreeBlk: Search the gLog2Phy table to get free block

nEraseBlock: Erase the used block

memset16: Fill data

nReadPages: CBW SCSI Read command

ECCSetup: ECC setup to store to internal ram buffers

CheckECC: Verify ECC

Log2Phy: Get Physical block based on the LBA

nCopyPages: Copy NAND data

nSearchFreeBlock: Wear-leveling search for free block from gLog2Phy table

nWritePages: CBW SCSI Write command

CorrectData/CorrectDataX: ECC correction in the EP6 Buffer

nNandMove: Internal move command for 2K NAND type

vend_cbw.c

Support for the NAND flash Manufacturing Utility command interface via the CBW. The subrou-
tines are:

Fifo6In: Setup EP6 for transfer data from NAND to FIFO6 Buffer

NandSendCmd: General send a command to NAND

NandRead: General read a page data from NAND

GetNandType: Get 4-byte NAND ID and 2-byte of status

NandSetAdd: General send address to the NAND

nReadCfgPage: Reading NAND configuration pages

nCopyBlock: Perform ECC correction while copying NAND data

GetNandCfg: Get NAND configuration information

CheckSignature: Check for special signature for the NAND configuration

handleVendorCBW: NandMfg.exe commands interface

loadEP2BC: Enpoint2 Control

fw.c

Frameworks based main routine:

main: main program for this firmware

SetupCommand: handle all chapter 9 commands via interrupt ISR_Sudav

resume_isr: Resume ISR

sendDescriptor: general sending descriptors

Globals.c Global variable definitions.

ide.c

Handles SCSI commands. The subroutines are:

IDECommand: Handles most of the UFI commands

cMedia: Check Media

waitForInBuffer: general polling endpoint 4 for IN buffer available

loadEP4BC: endpoint 4 control
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The following steps illustrate the CY3686 firmware debugging with the FX2LP Base board + NX2LP-
Flex board stackup configuration using Keil uVision. 

Note The CY3686 kit contains the Keil uVision2 evaluation version with a 4K code limit. To debug
and compile the modified code, customers must purchase a full version from http://www.keil.com/ 

1. On the FX2LP base board, ensure the following:

a. SW1 is set to 'Small EEPROM' and SW2 is set to 'EEPROM'. If the Small EEPROM image is 
corrupted, program it using the CyConsole utility with NX2LP-SmallEEPROM.iic located at 
<install directory>\CY3686 NX2LP-FLEX DVK\<ver>\ Boot Loader\. Follow 
the programming steps given in NAND FW Packaging Utility on page 27, but select the 'S 
EEPROM' button now.

b. The RS232 cable is connected from SIO-1 to the PC COM port

c. The USB cable is connected from J1 to the PC USB port

d. LED D7 is ON (green).

2. Uncheck the “Read Only” atttribute in all the firmware files. The default location of the firmware 
directory is: <install directory>\CY3686 NX2LP-FLEX DVK\<ver>\CY3686FW

3. Browse and click the CY3686fw.uv2 project file in the firmware directory to launch the uVision2 
tool. 

periph.c

Hooks required to implement the USB peripheral functions

TD_Init: Hardware/Software initialization

TD_Poll: Task Dispatcher hook for USB Mass Storage Class

ChkErr: ECC handler

stallEP2OUT: force STALL on endpoint 2

sendUSBS: send SCSI CBS

failedIn: force STALL on endpoint 4

mymemmovexx: general memory move subroutine

Globals.h Global variable references

gpif.c and gpif.h Header files containing hardware GPIF wave form.

scsi.h SCSI command set

CY3686fw.Opt Options for UV2 project

inand_fw.hex

nand_fw512.hex

nand_mc2k.hex

nand_fw2k.hex

nand_mc4k.hex

nand_fw4k.hex

Output file from the linker

inand_fw.hex: is the firmware file for NX2LP-Flex chip that support 512-NAND type

nand_fw512.hex: is the firmware file for FX2LP chip that support for 512-NAND type

nand_mc2k.hex: is the firmware file for NX2LP-Flex chip that support for 2K-NAND type

nand_fw2k.hex: is the firmware file for FX2LP chip that support for 2K-NAND type

nand_mc4k.hex: is the firmware file for NX2LP-Flex chip that support for 4K-NAND type

nand_fw4k.hex: is the firmware file for FX2LP chip that support for 4K-NAND type

CY3686fw.Uv2 UV2 project file

ezusb.lib FX2LP library file

fx2_intreg.inc
Include the definition for NX2LP-Flex interrupt vectors definitions and FX2LP interrupt 
vectors definitions

Filename Purpose

http://www.keil.com/
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4. The CY3686 NX2LP-Flex is shipped with the 2K-NAND type; select the NAND_FW2K option.

Figure 3-13.  Selecting NAND FW for 4K Page Device

5.  The "CY3686fw.uv2" setup assumes "COM1" is used; if the PC has an RS232 cable attached to 
a different COM port, perform these steps:

a. Right-click the NAND_FW4K project in the Files tab.

b. Select Options for Target 'NAND_FW4K'.

c. Click the Debug tab. Click the Settings button; the following window is displayed.

d. Using the drop-down menu, change the COM port and click OK.

e. Click OK until you exit all menus.
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Figure 3-14.  Setting up the COM Port for in Circuit Debugging

9. Press F7 to recompile the code. If successful, a window similar to the following is displayed.

Figure 3-15.  Compiling NAND FW

10. Download and run the firmware in debug mode.
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11.Click Download to download the code; then click the Reset button . If successful, a window sim-
ilar to the following is displayed.

Figure 3-16.  Downloading and Debugging NAND FW

12. Press F5 to run the firmware; it enumerates as a USB Mass Storage device and the PC desktop 
mounts the "Drive" letter if there is a programmed NAND device on-board the NX2LP-Flex DVK. 
You can start transferring files between the local drive to this "Removable Disk".
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4. Hardware

4.1 Overview

The CY3686 EZ-USB NX2LP-Flex DVK contains the following boards:

■ The FX2LP base board

■ The FX2 prototyping board

■ The NX2LP Flex board

4.1.1 FX2LP Base Board

This is the same board that is shipped with the CY3684 EZ-USB FX2LP DVK. This EZ-USB
Advanced Development Board provides a compact evaluation and design vehicle for the EZ-USB
FX2 family. The board provides expansion and interface signals on six 20-pin headers. Besides, the

board provides a set of GPIO push button switches, GPIO LEDs, an I2C seven segment LED, and
UART ports which enable users to quickly develop and test firmware for their applications. 

NX2LP-Flex is derivative of FX2LP enabled by the latter's flexible GPIF interface and the highly
configurable bootloader. Being the parent device, FX2LP can run the firmware targeted for a NX2LP
device.  

Using the standard RS-232 port available on FX2LP, the debugger interface of the Keil uvision tool
can be used to connect, download, and debug your custom firmware image on the target hardware.
This means the user can set break points and step through the code. LEDs and buttons on the
FX2LP board provide additional debug functionality.

When booted from the attached I2C-EEPROM preloaded with a special NAND loader image
(loader.iic), the FX2LP looks for the custom NX2LP NAND firmware from an attached NAND flash
device just like any other NX2LP device.

Figure 4-1 shows the FX2LP base board highlighting the key elements. The board is described in
detail in the EZUSB FX2LP DVK (CY3684) and only the sections relevant to the NX2LP - Flex DVK
are explained in this section.

http://www.cypress.com/?rID=14321
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Figure 4-1.  FX2LP Base Board and Key Components
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The default setting for the FX2LP Base board is shown in the following figure.

Figure 4-2.  FX2LP Base Board Switch Settings

4.1.2 FX2LP Prototyping Board

The prototyping board, also known as the "FX2 breadboard", is provided to support additional hard-
ware that the user may wish to add to the NX2LP flex DVK board and create prototypes for specific
applications.
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Figure 4-3.  FX2LP Prototyping Board

4.1.3 The NX2LP Flex Board

The NX2LP-Flex board is designed to support interfacing the CY7C68013, CY7C68033, and
CY7C68034 with standard NAND flash devices. Pad U1 provides a mount for the FX2LP/NX2LP
Flex controller chip while pad U2 enables loading an optional EEPROM. By default, these pads are
not populated with the respective components in order to enable the user to explore the different
options the NX2LP-Flex DVK provides to debug the NAND firmware. When U1 and U2 are popu-
lated, make sure that U12/D1 and U13 are populated. Refer to the schematics in DVK Board
Schematics chapter on page 59 for further details.

Pin Header 1
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Pin Header 3
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Pin Header 6

Pin Header 5

Pin Header 4
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Figure 4-4.  NX2LP Flex Board and Key Components

Note U4-U11 are NAND sockets.
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The NX2LP-Flex board supports the following NAND flash features:

■ 1-8 single-device or 1-4 dual-device NAND flash chips with ×8 organization

■ 512-byte for each page (BPP), 2048 (2K) BPP, and 4096 (4K) BPP NAND flash devices

❐ 512 BPP supports 512 MB to 1 GB NAND flash devices

❐ 2 K BPP supports 1 GB to 8 GB NAND flash devices

■ 4K BPP supports up to 32 GB NAND flash devices

■ Jumper options for flexible testing and configuration

■ Pin headers for easy debugging and signal analysis

■ 48-pin TSOP NAND flash package support

■ Write-protect switch

■ Dual-LED operation and power control features

■ Download-over-USB for device programming

4.2 NX2LP Flex Board Details

4.2.1 Jumper Settings and Switch Configurations

The NX2LP-Flex comes with the following jumper and switch settings.

Figure 4-5.  NX2LP Flex Board-Default Switch Settings
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4.2.1.1 NX2LP-Flex Board Jumper and Switch Configurations

Table 4-1.  NX2LP-Flex Board Jumper and Switch Configurations

The default configuration and functionality of the jumpers is discussed in NX2LP-Flex Board Hard-
ware Configuration on page 45.

Jumper/Switch 
Location

 Jumper/Switch Descriptions
 Default Jumper 

Install
 Connection

J3 Power on/off to EZ-USB NX2LP On 1-2

J4 Power on/off for all NAND flash devices On 1-2

J5 LED D7 enable/disable. NAND flash activity indicator. On 1-2

J6 LED D8 enable/disable (Spare)  On 1-2

J7  U4 enable/disable control  On 2-3

J8  U8 enable/disable control  On  2-3

J9  U5 enable/disable control  On  2-3

J10  U9 enable/disable control  On  2-3

J11  U6 enable/disable control  On  2-3

J12  U10 enable/disable control  On  2-3

J13  U7 enable/disable control  On  2-3

J14  U11 enable/disable control  On  2-3

J16 I2C enable/disable control On  1-2

SW1
Write-protect Switch ON 
Write-protect Switch OFF

Switch OFF 
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4.2.2 NX2LP-Flex Board Header Configurations

This design contains six logic analyzer headers. The functionality of these headers is described
here. Refer to the NX2LP-Flex board datasheet for specific chip pin descriptions and functionality.

Table 4-2.  NX2LP-Flex Board Header Configurations

Header Label  Header Pin  Pin Name  NX2LP-Flexboard signals

P1

1 NC No connect

2 VCC_3.3 3.3V Power

3 NC No connect

4 nXCE7 Chip enable #7

5 nXCE6 Chip enable #6

6 nXCE5 Chip enable #5

7 nXCE4 Chip enable #4

8 nXCE3 Chip enable #3

9 nXCE2 Chip enable #2

10 nXCE1 Chip enable #1

11 nXCE0 Chip enable #0

12 D7 Data 7

13 D6 Data 6

14 D5 Data 5

15 D4 Data 4

16 D3 Data 3

17 D2 Data 2

18 D1 Data 1

19 D0 Data 0

20 GND Ground

P2

1 NC No connect

2 VCC_3.3 3.3V Power

3 NC No connect

4 R_nB2 Ready/Busy 2

5 R_nB1 Ready/Busy 1

6 NC No connect

7 NC No connect

8 NC No connect

9 nXRE1 Read enable 1

10 nXRE0 Read enable 0

11 nXWE Write enable

12 NC3 Unused GPIO pins for NX2LP-Flex

13 NC2 Unused GPIO pins for NX2LP-Flex

14 nWP_SW Write-protect switch input

15 nWP_NF Write-protect NAND flash

16 nLED2 Chip active LED sink

17 nLED1 Data activity LED sink

18 ALE Address latch enable

19 CLE Command latch enable

20 GND Ground

P3  Unused header

P4 3 NC1 Unused GPIO pins for NX2LP-Flex

P4 Other pins  Unused 

P5 3 NC1 Unused GPIO pins for NX2LP-Flex

P5 Other pins Unused

P6 10 SDA I2C data

P6 11 SCL I2C clock

P6 Other pins Unused

http://www.cypress.com/?rID=14187
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4.2.3 NX2LP-Flex Board Hardware Configuration

This section describes how to configure the NX2LP-Flex board. Sockets are provided on the NX2LP-
Flex board for development convenience in testing a variety of NAND flash parts. Because of the
many different NAND types available on the market, it is important to configure the NX2LP-Flex
board properly to ensure correct operation. The following table provides four simple questions that
assist in understanding how to configure your board.

Note All NAND configuration changes must be performed after disconnecting from the USB bus.

Table 4-3.  NAND Flash Parameters

1. Insert NAND devices into sockets (U4-U11)

The NX2LP-Flex board supports up to eight single-device or four dual-device NAND flash chips. The
same part type (vendor, part number) must be loaded in the NX2LP-Flex board for it to function cor-
rectly. Do not mismatch NAND flash devices as it can corrupt data.

Warning: The NAND flash sockets are rated by their manufacturer for 50 insertions and can be
damaged by careless handling. However, with care, more insertions are possible. Use caution when
inserting or removing NAND flash devices from the sockets. Be certain to install the parts so pin 1 is
in the upper left corner. Pin 1 is clearly marked on the NX2LP-Flex board with a triangle at each
socket.

Depending on the response to Question #3, follow these directions:

■ Single-Device Parts - one CE pin

❐ Install the NAND flash devices in the following order until you reach the total listed in response 
to Q4: U4, U8, U5, U9, U6, U10, U7, U11

■ Dual-Device Parts - two CE pins

❐ Install the NAND flash devices in the following order until you reach the total listed in response 
to Q4: U4, U5, U6, U7

2. Configure NAND flash jumpers J7-J14

It is possible to enable or disable individual NAND flash chips using jumpers J7-J14. The NX2LP-
Flex device detects NAND flash in the following order:

■ For single-device parts: U4, U8, U5, U9, U6, U10, U7, U11

■ For dual-device parts: U4, U5, U6, U7

For example, for single-device parts, if U5 is disabled by shunting pins 1-2 of jumper J9 (see
Table 4-4.  U5 and the parts after it (U9, U6, U10, U7, and U11) are not detected by the NX2LP-Flex
at power on). 

By default J7-J14 should be shunted across pins 2-3. The following tables show how to enable or
disable NAND flash devices by configuring J7-J14. This is preferable to removing NAND flash
devices and extends socket life.

Questions

Q1: NAND flash vendor?

Q2: NAND flash part number?

Q3: Single- or dual-device part? 
(Note Single-device parts have one CE pin, dual-device parts have two CE pins.)

Q4: Total NAND flash devices (1-8 for single-device or 1-4 for dual-device)?



46 CY3686 EZ-USB® NX2LP-Flex™ Development Kit Guide, Doc. # 001-61287 Rev. *B

Hardware

4.2.3.1 Single-Device Parts

Individual NAND flash devices can be enabled and disabled as shown in the following table.

Table 4-4.  Single-Device Parts Configuration of J7-J14

4.2.3.2 Dual-Device Parts

For dual-die NAND flash devices, the jumpers must be enabled or disabled in pairs as shown in the
following table.

Table 4-5.  Dual-Device Parts Configuration of J7-J14

Jumpers
Jumper Settings

Shunt 1-2 Shunt 2-3

J7  Disable U4  Enable U4

J8  Disable U8  Enable U8

J9  Disable U5  Enable U5

J10  Disable U9  Enable U9

J11  Disable U6  Enable U6

J12  Disable U10  Enable U10

J13  Disable U7  Enable U7

J14  Disable U11  Enable U11

Jumpers
Jumper Settings

Shunt 1-2 Shunt 2-3

J7 and J8  Disable U4  Enable U4

J9 and J10  Disable U5  Enable U5

J11 and J12  Disable U6  Enable U6

J13 and J14  Disable U7  Enable U7
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5. NAND Manufacturing Utility

5.1 Operation Overview

The NX2LP NAND Programming Utility is an application designed to download vendor configuration
parameters to an NX2LP NAND memory device and automatically initialize it with FAT32 formatting.

The utility can be used to program previously un-programmed (that is, "raw") NAND flash or to
reprogram preconfigured NAND flash devices and enumerate as Windows Mass Storage Class
devices.

The application automatically detects the presence of a usable NX2LP device on the USB. Connect
the NX2LP device to the PC's USB and run the NX2LP NAND Programming Utility. The status bar at
the bottom of the application window displays the identified device.

The current selections for all parameter fields are stored each time the program closes. These are
then restored each time the program runs. The parameters presented by the application can be
locked such that the operator only has the ability to view the parameters and to click the Wipe and
Program Device button. This facilitates the configuration of the software parameters by one
"administrator" while restricting the functionality to a one-button "program" operation for a
manufacturing operator.

When the program is launched, the status bar indicates "No usable device detected" if no NX2LP-
Flex devices are attached to the USB.

Figure 5-1.  NX2LP NAND Programming Utility

When you attach a NX2LP device with unprogrammed Nand flash to the USB the first time, Windows
asks for a device driver. Refer to the section Installing the CY3686 DVK Device Drivers on page 14
for further details.
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After Windows finds the driver for the NX2LP device, NandMfg identifies the flash parts which
populate the device and displays information about them in the NAND Device box. However, if “Add
New Part" pops up, follow the instructions given in section 5.7.

Figure 5-2.  Unprogrammed USB Device

At this point, the NAND flash device is ready to be programmed with the parameters displayed.
Select the appropriate config file and then click Wipe and Program Device to program the
parameters into the device and format the media to FAT32.

5.2 Vendor Parameters

The Vendor Parameters are USB and SCSI parameters that are reported by the device to the
operating system when the device is attached to the PC.

■ Manufacturer

The manufacturer string can contain up to 23 characters. The entry field limits the length of the string
for you.

■ Product Descr

The product description string can contain up to 23 characters. The entry field limits the length of the
string for you.

■ SCSI Device Name

The SCSI device name string can contain up to 24 characters. The entry field limits the length of the
string for you.

■ Serial Number

All USB devices should report a unique serial number. This allows the operating system to track
separate devices of the same type that are connected to the computer. 

The NX2LP programmer programs each device with a serial number composed of 15 hexadecimal
characters.
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■ Vendor ID

The vendor ID is a two-byte value assigned to each USB device vendor by the USB Implementors'
Forum (USBIF). The value should be entered as a hexadecimal value with a prefix of "0x". For
example, the Cypress vendor ID is 0x04B4.

■ Product ID

The product ID is a two-byte hexadecimal value that the vendor assigns to a product. The value
should be entered as a hexadecimal value with a prefix of "0x". While programming the NAND flash,
using the NANDMfg.exe, ensure that the PID displayed on the utility is not 0x4617, 0x8613, 0x6823,
or 0x0082. If it displays any of these PIDs in the PID field, then manually change the value in the
utility to any value of your choice other than the PIDs mentioned here. These PIDs are signed by
Microsoft for the cyusb.sys driver. When programmed with these PIDs, the programmed NAND flash
does not enumerate as a USB Mass Storage Device.

Figure 5-3.  Vendor Parameters

5.3 Options Menu

The Options menu has four settings, which should be configured before connecting any NX2LP
device. Click on any of the items in the drop-down menu to check or uncheck it.

■ Auto Program on Device Connect

If this item is checked, the programming utility automatically begins programming the device when it
is connected. The operator does not need to click the Wipe and Program Device button. Erase the
NAND device using the short key, CTL + W, and then press the RESET button S1 on FX2LP. Then,
the NANDMFG tool automatically downloads firmware and formats the NAND device. Press RESET
again to observe a removable disk.

Note The utiity does not automatically re-program a pre-configured device.

■ Enable Write Protect

If you check this item, your device implements a write-protect switch. If this item is checked, the util-
ity does not attempt to format the media. If you enable the write protect bit from the tool, the device
always enumerates as a removable disk. If you disable the write protect bit from the tool, the device
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always enumerates as a hard disk. This feature is used in applications where you do not want to
enumerate any removable device. If the device enumerates as a hard drive the first time, you must
first initialize it and then format it for use.

Figure 5-4.  Options Menu

■ Manual entry of Serial Number

By default, the NX2LP Programmer automatically generates a new 15-digit serial number after each
successful programming of the device. The operator can enter the serial number manually by check-
ing Manual entry of Serial Number.

Note Valid serial numbers are at least 12 characters in length and contain only hexadecimal digits. If
the Manual entry of Serial Number item is not checked when the "Program Device" button is
clicked, the displayed serial number is programmed to the device. Then, a new serial number is gen-
erated and displayed. Therefore, the displayed serial number is always the one that is about to be
programmed and not the one that has already been used.

■ NAND Page Size = 512 bytes

It is crucial that this item accurately reflects the type of NAND flash part that is being programmed.
Check this item if the NAND flash parts in the device have a page size of 512 bytes. If the parts have
a larger page size (typically 2048/4096 bytes), make sure this item is not checked.
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5.4 Device Menu

This utility provides four functions that are invoked by clicking on them. Alternately, you can press
down the CTRL key while pressing another key as a shortcut. 

Figure 5-5.  Device Menu Options

■ Wipe (Ctrl + W)

This command completely erases the contents of all the NAND chips in the attached device.

■ Format Media(FAT32) (Ctrl + F)

This command toggles formatting of the media ON and OFF. By default, the utility imposes a FAT32
format on the media at the conclusion of the programming process. If you do not want FAT32 format-
ting, this step can be disabled by pressing CTRL-F. The FAT32 format can be externally done from
Windows PC by right-clicking the removable disk and selecting the Format option in the menu. After
Format completion the removable disk can be accessed.

■ Program

After erasing the NAND device press RESET button S1 on the EZ-USB FX2LP board. The NAND-
MFG tool enables this button only after a proper Erase cycle, enabling you to program the NAND
flash. Re-programming an already programmed NAND corrupts the NAND memory device.

■ Wipe and Program

This option is provided to avoid NAND device corruption by re-programming an already programmed
NAND device. The button "Wipe and Program Device" also serves the same purpose. You can either
choose to erase and then program separately using the above options, or perform the entire opera-
tion in a single step using this feature.
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5.5 CTRL Key Commands

This utility provides three functions that are invoked by holding down the Ctrl key while pressing
another key. These functions are used occasionally and, therefore, not shown in the user interface of
the utility.

■ Lock: CTRL-l (L)

This command locks and unlocks the user interface. To prevent accidental changes to vendor
parameters or options, access to these fields can be disabled by pressing Ctrl-l to lock the user inter-
face.

■ Wipe: CTRL-w

This command, CTRL-w, completely erases the contents of all the NAND chips in the attached
device.

WARNING: This command results in permanent loss of all data and formatting in the device. It
restores the device to the raw, pre-configured state.

■ Formatting On/Off: CTRL-f

This command toggles formatting of the media ON and OFF. By default, the utility imposes a FAT32
format on the media at the conclusion of the programming process. If you do not want FAT32 format-
ting, this step can be disabled by pressing CTRL-f.

5.6 Programming Devices

The NX2LP NAND Programming Utility is used to configure a connected NAND flash device. Pro-
gramming comprises downloading the displayed parameters along with a set of other configuration
settings, and then formatting the drive media in the FAT32 format. The configuration in use can be
displayed by clicking on Help > About.

The following figure shows that the default configuration is used. Other configurations, if provided,
can be selected using File > Select Configuration.

Figure 5-6.  Default Configuration in Use

When an un-configured NAND flash device is detected by the Programming Utility, the status bar at
the bottom of the window displays "Connected to Cypress NX2LP - Unprogrammed USB Device".
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Figure 5-7.  Unprogrammed USB Device

To program the Vendor Parameters and the Configuration Settings to the flash device, click Pro-
gram Device. After successful programming and formatting, the status bar displays "Device pro-
grammed and formatted". NandMfg supports formatting only for flashes with 2k or 512-byte page
sizes. It relies on the host to format 4-k page flashes.

Figure 5-8.  Device Programmed and Formatted

At this point, the device is configured as a fully functional USB Mass Storage Class device. 
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Figure 5-9.  Programmed Device

5.7 Reprogramming Devices

The NX2LP NAND Programming Utility can be used to update (that is, reprogram) an NAND flash
device. When an NX2LP device is already programmed, Windows sees it as a USB Mass Storage
Device. Because the NX2LP NAND Programming Utility can only program NAND flashes mounted
on Cypress NX2LP devices, it needs a method to discern NX2LP storage devices from other (non-
NX2LP) devices. This distinction is made based on the device's VID/PID. 

Figure 5-10.  Device Reprogramming

If you connect a programmed, functional, NX2LP-based storage device and the NX2LP NAND Pro-
gramming Utility displays "No usable device detected" in the status bar, you must enter the VID/ PID
of the connected device into the corresponding fields of the utility. When the cursor moves away
from the PID field, the utility checks to see if the attached device matches the new VID/PID. 
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Figure 5-11.  Device Detected after VID Change

Note that you can reprogram a NAND device only after erasing the existing contents. Until the NAND
device is erased and RESET (disconnected and reconnected), the Device > Program option is dis-
abled. Cypress recommends using the Wipe and program Device button, which takes care of the
entire process. If the NandMfg tool is stuck on reconnect with the status 'Identifying Device..', then
make sure that the Configuration file selected is correct before reconnecting.

5.8 Support for NAND Parts

The NX2LP Programming Utility needs to know several parameters about the actual NAND chips
used in the NX2LP memory device. Rather than require user entry of these parameters, the utility
searches for these parameters in the NandParts.xml file located at <install direc-
tory>\CY3686 NX2LP-FLEX DVK\<ver>\MfgTool.

If a part cannot be found in the lookup table is detected, the following dialog box pops up. For the
NAND parts to function properly with the NX2LP, it is crucial that the parameters in the dialog are set
accurately.

The Manufacturer ID and the PID are values that the NX2LP retrieved from the NAND parts them-
selves. The user cannot change these fields. They serve as the index into the lookup table. The
other parameters should be obtained from the NAND device's datasheet, provided by the NAND
device manufacturer.
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Figure 5-12.  New NAND Part

When you click Save, the parameters are saved in a second lookup table called OtherParts.xml,
located at <install directory>\CY3686 NX2LP-FLEX DVK\<ver>\MfgTool. This table is
always searched before NandParts.xml when the utility tries to identify a part.

OtherParts.xml is not distributed with the NX2LP Programming Utility because it does not yet exist
and is created by the utility when a new part's parameters need to be saved. This means that, if
wrong values are mistakenly saved using the dialog shown in the previous screenshot, the Other-
Parts.xml table can be manually deleted without breaking the tool.

(CAUTION: Deleting OtherParts.xml removes all parts whose parameters are manually entered
through this dialog. If you added several new parts and decide to delete the file, you must make a
backup copy first).

Finally, as indicated by the .xml file extension, OtherParts.xml is an XML file. It can be easily modi-
fied with a simple text editor. The structure of the XML elements that comprise the file is quite simple.
With a little XML knowledge and a limited amount of pattern matching skill, the file can be manually
modified to remove bad entries or add additional ones. OtherParts.xml and NandParts.xml use iden-
tical XML element structures).
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A. Appendix

A.1 Firmware Design Notes

The CY3686 EZ-USB NX2LP-Flex DVK is a flexible NAND flash solution that provides additional
features that can be added to a USB thumb drive solution. The Cypress EZ-USB NX2LP-Flex Mass
Storage reference design connects the EZ-USB NX2LP-Flex to the following device types:

■ 512 byte page, 2 KB page, and 4 KB page flash chips

■ 25 ns - 90 ns access time chips

■ Flash chips with single and multiple chip selects (maximum eight)

Refer to the document, “NX2LP-Flex™ USB to NAND flash Firmware Design Notes - AN61347", on
http://www.cypress.com/?rID=43431 for more information. It is also located in the installed directory
at <install directory>\CY3686 NX2LP-FLEX DVK\<ver>\Documentation. 

A.2 USB Mass Storage Testing

The USB mass storage device testing is done to verify if there are any failures when reading from or
writing to the device. It includes a regression test, which transfers data to the USB Mass Storage
evice, reads back the data, and compares to check data integrity issues. The codes for Windows
based systems and Linux based systems are different.

Refer to the USB Mass Storage Testing guide on http://www.cypress.com/?docID=21890 for more
information. It is also located in the installed directory at <install directory>\CY3686
NX2LP-FLEX DVK\<ver>\Documentation (assuming default installation).

A.3 Handling SOP Sockets

The NAND Flex DVK board includes eight 48-pin TSOP NAND sockets. These parts are delicate
and, therefore, must be handled with care. 

The SOP Sockets in this DVK have a positive locking lid design. The lock is attached to the left lid
and slides back and forth in a direction parallel to the hinge pins. The sockets are shipped in the
locked condition.

http://www.cypress.com/?rID=43431
http://www.cypress.com/?docID=21890
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To open them, first slide the lock sideways (approximately 1 mm) to the unlocked position.

Both lids are now free to be opened by rotating them on their respective hinges.

Place the SOP component into the socket.

The lids must be closed simultaneously to assure proper seating of the SOP component. If this is not
observed, the component shifts to the center of the socket resulting in an unsatisfactory electrical
connection. Now, while maintaining a downward pressure on the lock, slide it sideways to it is in a
locked position.
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A.4 DVK Board Schematics

Figure A-1.  FX2LP DVK Board Schematic
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Figure A-2.  NX2LP-Flex DVK Board Schematic
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A.5 DVK Board Layout

Figure A-3.  FX2LP DVK Board Layout 
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Figure A-4.  FX2 Prototype Board Layout
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Figure A-5.  NX2LP-Flex DVK Board Layout
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A.6 Frequently Asked Questions

Q1: What is the maximum size of the hex file that can be programmed on to the NAND flash
using the NX2LP programming utility?

A1: The NX2LP programming utility can only handle hex code files upto 16 KB in size (0x0000 -
0x3FFF), which is the internal RAM boundary of the NX2.

Q2: What does the default.nx2 file contain? 

A2: The default.nx2 file packages different hex files built off the NX2LP code. The default.nx2 file
provided with the CD or that which is downloaded from the website, packages the hex file for a 512-
byte page NAND flash chip and 2-K page NAND flash chip together. So, when the Program Device
button is clicked in the NX2LP Programming Utility, upon checking the page size of the NAND flash
chip, the pertinent code is downloaded onto the NAND flash chip. You can build your own .nx2 files
using the buildnx2 application. The NX2 currently supports interface only with 512-byte and 2-K
page sizes.

Q3: What is the functionality of the RB pins for the CY7C68023?

A3: The NX2LP has two R/B pins to support a protocol known as "interleave". This allows the NX2LP
to work with a different NAND flash chip (or die in a chip) while another is busy. When interleave is
not used (almost all cases), both of the R/B signals on the NX2LP need to be tied together so that
the proper ready/busy operation is detected.

Q4: If there is an ECC error while reading data from the NAND, how does NX2LP/NX2LP-Flex
inform the host about the error?

A4: If there is a ECC error while reading data from the NAND, NX2LP/NX2lP-Flex corrects the error.
If it is a correctable error, it corrects the data and then sends the data to the host. If it is an uncorrect-
able error, it stalls the status phase of the mass storage read request to inform the host that there
was an error. In both cases the data is copied to a new block and the old block is marked as a bad
block. If there is an ECC error while reading data from the NAND, NX2LP/NX2lP-Flex corrects the
error. If it is a correctable error, it corrects the data and then send the data to the host. If it is an
uncorrectable error, it stalls the status phase of the mass storage read request to inform the host that
there was an error. In both cases, the data will be copied to a new block and the old block will be
marked a bad block.

Q5: How do you add new NAND flash parts to NX2LP Using the NX2LP Programming Utility?

A5: NX2LP is currently compatible with SLC NAND flash of 512-byte and 2K-byte page sizes only.
The NX2LP Programming Utility needs to know several parameters about the actual NAND chips
that are used in the NX2LP memory device. Rather than require entry of these parameters by the
user, the utility looks these parameters up in a file called NandParts.xml. NandParts.xml file can be
found in the path <install directory>\CY3686 NX2LP-FLEX DVK\<ver>\ after the installa-
tion of CY3686 EZ-USB NX2LP-Flex Development Kit. If a part is detected that cannot be found in
the lookup table, the dialog box added as an attachment pops up. For the NAND parts to function
properly with the NX2LP, it is crucial to set the parameters in the dialog accurately. The Manufacturer
ID and the Product ID are values that the NX2LP retrieved from the NAND parts themselves. When
the Save button is clicked, the parameters are saved in a second lookup table called OtherParts.xml.
This table is always searched first, before NandParts.xml, when the utility tries to identify a part. After
the details have been entered and saved, the new NAND flash part will have been added to NX2LP
and will be identified automatically when connected the next time.

Q6: How do you modify the parameters of a NAND flash part previously added to NX2LP?

A6: The files, OtherParts.xml and NandParts.xml, act as lookup tables to retrieve the information of a
previously added NAND flash parts. Both these files can be found in the path <install direc-
tory>\CY3686 NX2LP-FLEX DVK\<ver>\ after the installation of the CY3686 EZ-USB NX2LP-
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Flex Development Kit. If the particular NAND flash part is present in the file, it shows up on the
NX2LP programming utility. If a part that cannot be found in the lookup table is detected, the "Add
New Nand Part" dialog box pops up. For the NAND parts to function properly with the NX2LP, it is
crucial to set the parameters in the dialog accurately. After entering the parameters from the data-
sheet correctly click on save. When the Save button is clicked, the parameters are saved in Other-
Parts.xml.

The parameters of NAND flash need to be modified if they have been wrongly entered the first time
altering the memory density of the particular NAND flash part. Once the parameters are entered, the
next time the device is connected to USB, it shows up with the same wrong memory density in the
NX2LP programming utility. To modify the parameters, follow these steps:

■ Right click on OtherParts.xml and select Open with WordPad option.

■ Select the particular entry for the NAND flash part whose parameters have to be re-entered and            
delete it.

■ Save the OtherParts.xml file after deleting the particular line and reset the NX2LP board.

■ Open the NX2LP programming utility and the "Add New Nand Part" dialog box opens since the 
Nand Part cannot be found in the lookup table.

■ Enter the parameters correctly and click Save to create a new entry in the OtherParts.xml file with 
the updated parameters.

Q7: FAT32 Formatting fails when I click on Program device in the NX2LP Programming Utility.
What do I do to avoid successfully program the device.

A7: Check the following steps if using the CY3686 EZ-USB NX2LP-Flex Development Kit. 

1.  Reset the board, it should enumerate as an EEPROM missing device with PID of 8613.

2.  Now, you can open the EZ-USB interface and download the bootloader hex file onto the large 
EEPROM. On resetting the board it should enumerate as a bootloader with PID of 6823.

3.  Now you can disconnect the device, and then open the NX2LP programming utility.

4.  Once you open the utility, reconnect the device.

5.  If the NAND flash is not part of NAND Parts.xml, then enter the NAND flash details in the pop-up 
box that comes up.

6.  You can now see that it is connected to NX2LP Unprogrammed with a PID of 4617. Now, if you 
click the Program Device button, it works fine.

After checking this, if you still have the same problem then ensure that you have disabled the Auto-
program option. This ensures the file you are pointing to is the file that is downloaded to the flash.
Then, try programming the flash after erasing all its contents using Ctrl+W. Sometimes, when this
happens, just erasing the flash and reprogramming it usually works. If your device is being identified,
but programming fails, then it mostly points to an error in the bootloader, that is, the default.nx2 file.
Ensure that you point to the correct .nx2 file. 

Check if the pins of the flash are all fine, as even that can cause a download failure at times.

You can obtain the bootloader hex file and the .nx2 file from CY3686 EZ-USB NX2LP-Flex DVK con-
tents, either with the CD/DVD or you can download it from the website.

Q8: Why does the chip capacity reported by the utility not match with the device capacity
seen in Mass storage drive properties, even after the device has been formatted?

A8: NX2LP firmware needs to implement wear leveling (causing the logical to physical translation).
To do this, it exposes only 1000 logical blocks per 1024 physical blocks. The firmware internally
organizes the NAND Flash into zones. Each zone is 1024 blocks. Only 1000 blocks can be used
from each zone for storing data at a time to implement the wear-leveling. Based on this architecture,

www.cypress.com/go/CY3686
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we can calculate the logical reported size of the disk for a 512-MB NAND with 2K page size
(assumption is 64 pages per block).

NANDMfg.exe calculates the physical size of the device as 2048B (bytes per page) * 64 (pages per
block) * 1024 (physical blocks per zone) * 4 (zones) = 512MB (M = 1024 * 1024). The firmware
reports the logical size of the device to the OS as 2048B (bytes per page) * 64 (pages per block) *
1000 (logical blocks per zone) * 4 (zones) = 500MB (M = 1024 * 1024) = 512000KB (512MB in mar-
keting terminology).

So, when you see 499 MB in the OS, this is expected as some space used up by the file system for-
matting is never reported.

Q9: Why does the NandMfg.exe utility get stuck when the status reads 'Identifying device...' ?

A9: The user needs to choose appropriate configuration if not selected already before resetting the
DVK or plugging in the DVK. Erase action is initiated from the NandMfg.exe as a simple vendor com-
mand implemented in the firmware. So it is important for this firmware to be correct as to the one
selected in the NandMfg.exe (Help > About).

When there is no firmware stored on the NAND Flash, or if there is no NAND Flash connected, the
configuration selected (shown in Help->About) will be downloaded to the FX RAM (there was a hard
coded bootloader to do this on NX2LP Li-ROM and for NX2LP-Flex this bootloader sits on the I2C
EEPROM of FX2LP DVK board). Now, this firmware will perform all actions as directed by the user
via NandMfg.exe. 
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